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Inhalt 



� 
�Übersicht über das SDK 
� Wo bekomme ich es? 

� Wie funktioniert es? 

� Was ist enthalten? 

�Debugging 
� Was bietet das SDK zum Debuggen? 

� Wie überprüfe ich die Performance meins Programms? 
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Ziel 



� 
� Einführung 
� InstallationInstallationInstallationInstallation    
� Windows 

� Linux 

� IDE/Eclipse 

� Grundlegende Funktionen 

� Bestandteile des SDKs 

�Debugging 

�NDK 
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Inhalt 



� 
�Download von 
http://http://http://http://developer.android.com/sdk/index.htmldeveloper.android.com/sdk/index.htmldeveloper.android.com/sdk/index.htmldeveloper.android.com/sdk/index.html    

� Entpacken (Irgendwo) 
� android-sdk-<Plattform> 
� android-sdk-linux 

� JDK überprüfen (>= 5) 
� android-sdk-<Plattform>/tools  zu PATH hinzufügen 
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Installation 



� 
� Windows:  Systemsteuerung\System und Sicherheit\System � 

Erweiterte Systemeinstellungen -> Umgebungsvariablen  
� (mit Semikolon trennen; keine Leerzeichen) 

�  Wichtig bei Eclipse Plug-In 
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Installation: Windows 



� 
� In /home/<Benutzer> 

� ~/.bash_profile oder ~/.bashrc    ändern 
� Nach PATH suchen 
� Oder selber machen:  export  

 

� tools/ hinzufügen 

� 32bit Kompatibilität sicherstellen 
� Ubuntu z.B. apt-get install ia32-libs 
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Installation: Linux 

PATH=${PATH}:<dein_sdk_Pfad>/tools 



� 
� Android macht's mit allen  
� (auch Emacs) 

� Am besten: Eclipse 
� Eigenes Plugin von Google 
� Kontrolle des Emulators/Device  

� Syntaxvervollständigung 

� Etc. 
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Installation: IDE 



� 
� ADT für Eclipse 
� Neu: 0.9.6 – März 2010 

� Help -> New Software 

� https://dl-ssl.google.com/android/eclipse/ 
� Bei Problemen http nutzen 

� Pfad zum SDK 
� Window -> Preferences -> Android -> SDK Location 
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Installation: IDE 



� 
� Einführung 
� Installation 

� Grundlegende FunktionenGrundlegende FunktionenGrundlegende FunktionenGrundlegende Funktionen    

� Bestandteile des SDKs 

�Debugging 

�NDK 
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� 

11/60 

Android Plattformen 

� Erstellen von AVDs 

� API-Level aussuchen 
� z.Z. Android 2.1 Eclair 

� Dokumentation 

� Updates 

� Beispiele 

� API Addons 
� z.B. Google APIs 
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� Bestandteile des SDKs 
� ToolsToolsToolsTools    

�Debugging 

�NDK 
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� 
� Tools 
� Erstellen eines AVDsErstellen eines AVDsErstellen eines AVDsErstellen eines AVDs    

� Erstellen Erstellen Erstellen Erstellen eines Projektseines Projektseines Projektseines Projekts    

� Anwendung startenAnwendung startenAnwendung startenAnwendung starten    

� SDSDSDSD----Karte erstellenKarte erstellenKarte erstellenKarte erstellen    

� Skalierbares UI 

� Aufbau des UIs 

� Automatische UI Analyse 
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Inhalt 



� 
� Tool: android oder GUI 

 

�Welche Targets? 
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 Erstellen eines AVDs 

$ android list targets 
Available Android targets: 
id:1 
    Name: Android 1.1 
    Type: platform 
    API level: 2 
    Skins: HVGA (default), HVGA-L, HVGA-P, QVGA-L, QVGA-P 

$ android create avd -n <Name> -t <targetID>  



� 
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 Erstellen eines AVDs 



� 
�Möglichkeit Skins zu benutzen 
� Nexus One Skin: 
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 Erstellen eines AVDs 



� 
 

 

 

 

�Update 
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 Projekt erstellen 

$ android create project \ 
 --target <target_ID> \ 
 --name <dein_Projekt_name> \ 
 --path /pfad/zu/deinem/Projekt\ 
 --activity <dein_activity_Name> \ 
 --package <dein_package_Namensraum> 

$ android update project  
$ android update project --name <Mein_Programm>  
 --target 8 –path <PfadZumProjekt> 



� 
� In Eclipse: 
� File->New->Other->Android->Android Project 
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Projekt erstellen 



� 
 
� Installiert die Anwendung im Emulator 

� Aus dem normalen „App-Menü“ starten 
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Anwendung starten 

$ adb install /Pfad/zu/deinem/Programm.apk 



� 
� In Eclipse: 

� Rechtsklick auf Projekt: Run As->Run Configuration 
� Anwendung startet automatisch 
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Anwendung starten 



� 
�Wenn nicht beim Erstellen des AVDs geschehen 

�Virtuelle SD-Karte  

 
� FAT32 

� SDHC – Standard 
� SDXC – Vielleicht irgendwann 

�Mount 
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SD-Karte erstellen 

$ mksdcard –l <Label> <Größe>[K|M] <Datei> 

$ emulator -sdcard <Datei> -avd <VirtuellesDevice> 



� 
� Tools 
� Erstellen eines AVDs 

� Erstellen eins Projekts 

� Anwendung starten 

� SD-Karte erstellen 

� Performance durch Alignement 

� Interprozesskommunikation 

� Skalierbares UISkalierbares UISkalierbares UISkalierbares UI    

� Aufbau des UIsAufbau des UIsAufbau des UIsAufbau des UIs    

� Automatische UI AnalyseAutomatische UI AnalyseAutomatische UI AnalyseAutomatische UI Analyse    
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� 
�WYSIWYG oder XML 

� Rudimentäres Drag & Drop 

� XML vergleichbar mit XAML oder XHTML 
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Skalierbares UI 



� 
�Draw9 
� WISIWYG Editor für NinePatch Grafiken 
� NinePatch -> skalierbare UI Elemente auf PNG basis 
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Skalierbares UI 



� 
�Hierarchy Viewer 
� GUI – Tools 
� Zugriff auf den Emulator 

� Ermöglicht Layout View und Display View bzw.  
Pixel Perfect View 
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Aufbau des UIs 



� 
� Layout View 
� 3 Ansichten 
� „Tree View“ 
� Hierachisches Diagramm der Ansicht 

� „Properties View“  
� Eigenschaften der ausgewählten Elemente 

� „Wire-frame View“  
� Skizze des UIs 
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Aufbau des UIs 



� 
� Pixel Perfect View 
� 3 Ansichten 
� „Explorer View“ zeigt die Elementhierarchie als Liste 

� „Normal View“ zeigt die normale Ansicht des Geräts 
� Zeigt die Grenzen der einzelnen UI-Elemente an 

� „Loupe View“ zeigt die selbe Ansicht pixelgenau 

� Möglichkeit Bilder als „Overlay“ zu laden 
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Aufbau des UIs 



� 
� layoutopt 
� Analysiert die dem UI zugrundeliegenden XML-Dateien 

� Testet das UI gegen einen Regelsatz 
� Findet Mängel und gibt Ratschläge 
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Automatische UI Analyse 

$ layoutopt samples / 
samples/compound.xml 
 7:23 The root-level <FrameLayout/> can be replaced with <merge> 
 11:21 This LinearLayout layout or its FrameLayout parent is useless 
samples/simple.xml 
 7:7 The root-level <FrameLayout/> can be replaced with <merge> 
samples/too_deep.xml 
 -1:-1 This layout has too many nested layouts: 13 levels, it should have <=10 
 28:81 This LinearLayout layout or its LinearLayout parent is useless 
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Inhalt 



� 
� Traceview: Grafische Anzeige des Logs 

 

 

� SD-Karten Image notwendig 

� Datei herunterladen 
� adb pull /sdcard/calc.trace  <Pfad> 

� Datei anzeigen 
� traceview <Pfad> 
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Syslog Anzeigen 

//startet tracing nach „/sdcard/cal.trace“ 
Debug.startMethodTracing(„calc“); 

//stop tracing 
Debug.stopMethodTracing(); 



� 
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Syslog Anzeigen 

� Profile Pane 
� Zeit in Methoden 

� Inclusive 
� Mit Subfunktionen 

� Exclusie 
� Nur die Methode 

 

� Zeigt das ausführen 
von Threads 

 



� 
� dmtracedump 
� Erzeugt ein Graphen, der den Aufrufstack repräsentiert 
� Benötigt Graphviz 
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Syslog Anzeigen 
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� Einführung 

� Bestandteile des SDKs 

�DebuggingDebuggingDebuggingDebugging    
� Syslog Anzeigen 

� The The The The MonkeyMonkeyMonkeyMonkey    

� Android Debug Bridge 
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� Performance 
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� 
� Stresstest des UIs 

� Erzeugt zufällige Ereignisse 
� Klicks 

� Berührungen 

� Gesten 

� Systemereignisse 

� Ereignisstyp einschränkbar 
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The Monkey 



� 
� Bearbeitet von einem Package 

 

� Stoppt bei Fehlern 
� Unbehandelten Exceptions 

� Crash 

� „application not responding“ Error 
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The Monkey 

$ adb shell monkey -p dein.package.Name -v 500 
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� Einführung 

� Bestandteile des SDKs 

�DebuggingDebuggingDebuggingDebugging    
� Syslog Anzeigen 

� The Monkey 

� Android Android Android Android DebugDebugDebugDebug    BridgeBridgeBridgeBridge    

� Dalvik Debug Monitor 

� Performance 

�NDK 

 36/60 

Inhalt 



� 
� Abkürzung: adb 

�Vielseitig 
� Debugging 

� Datenübertragung 

� Shell zugriff 

� Besteht aus Client, Server und Daemon 
� PC: Client, Server 

� Emulator oder Device: Daemon 
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Android Debug Bridge 



� 
� Adb Server läuft auf Port 5037 

� Emulator / Device auf Port 5555-5585 (ungeraden) 
� Android Console auf den geraden Ports (Port – 1) 
� adb braucht beide 

�Client-Server Struktur 
� Normal: ein Rechner; ausbaufähig 

� einfache Kommunikation 

� Bei mehreren Adb-Daemons :  
� Gibt Liste der Daemons aus 
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Android Debug Bridge 

$ adb devices 



� 

Android Debug Bridge 
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Emulator 1 

Daemon 

PC 
Client 

Server 

Emulator 2 

Daemon 



� 
�Kann Programme installieren 

 

�Kann mit mehreren Daemons umgehen 

 

�Möglichkeit zum Port Forwarding 

 

�Datenübertragung 
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Android Debug Bridge 

$ adb install <Datei> 

$ adb -s emulator-5556 install <Datei> 

$ adb forward tcp:6100 tcp:7100 

$ adb push / adb pull  



� 
� Logdatei anzeigen 
 

� Bugreport erstellen 
 
� Gibt kompletten Gerätestatus aus  
� Kombination aus: 
� Logcat 
� Dumpsys 
� Dumpsate 

� Emulator ohne laufende Programme 1,32MB an Text 
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Android Debug Bridge 

$ adb logcat <Filter> 

$ adb bugreport 



� 
� Logcat 
� Zeigt System Debug Informationen an 

� Filter 
� V – Verbose (niedrigste Priorität: alles wird ausgegeben) 
� D - Debug 
� I - Info 
� W - Warning 
� E - Error 
� F - Fatal 
� S – Silent (höchste Priorität: nichts wird ausgegeben) 
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Android Debug Bridge 



� 
� Logcat Filter: 
 
 
� Info zu ActivityManager 
� Silent zu Rest 

� Logcat Format: 
� -v <eineOption> 
� brief, process, tag, thread, raw, time, long 

� Logcat andere Logs 
� Radio, events, main (default) 
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Android Debug Bridge 

$ adb logcat Activity:Level 
$ adb logcat ActivityManager:I *:S 



� 
� Shell 

 

� Binärdateien in /system/bin 
� Einige *nix Tools vorhanden 
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Android Debug Bridge 

$ adb shell 

$ adb shell top /reboot / dd / mount /… 



� 
� Sqlite3 Database 

 

� .help für Hilfe 

�Grundlegende SQL Syntax 
� Create table 

� Insert 

� SELECT FROM WHERE 
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Android Debug Bridge 

$ adb shell sqlite3 
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� Bestandteile des SDKs 
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� Syslog Anzeigen 

� The Monkey 

� Android Debug Bridge 
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� 
� Anzeige des Heaps und Stacks 

� Schrittbasiertes Debugging mit Breakpoints 

�Übersicht über Garbage Collection 

�Möglichkeit das Gerät „anzurufen“ 
� Oder SMS 

� GPS Position bereitstellen  

� Manuell (default ist irgentwo vor Afrika ☺) 

� Per GPX oder KML Datei 
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Dalvik Debug Monitor 



� 
�Debugging für die Dalvik Virtual Machine 

� Zwei Ausführungen 
� Ähnlich dem JDK Debugger 

� Eigenständiges GUI oder IDE Plugin 
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Dalvik Debug Monitor 



� 
�Debugging für die Dalvik Virtual Machine 
� DDM Debugging: 
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Dalvik Debug Monitor 



� 
�Debugging für die Dalvik Virtual Machine 
� Normales Debugging in Eclipse: 
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Dalvik Debug Monitor 



� 
� File Explorer 

� Bildschirmfoto 

� Prozessanzeige (Basiert auf: ps –x) 

� Zugriff auf logcat / dumpsys / dumpstate aus dem UI 
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Dalvik Debug Monitor 
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� Einführung 

� Bestandteile des SDKs 

�DebuggingDebuggingDebuggingDebugging    
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� PerformancePerformancePerformancePerformance    
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� 
� Tool: Zipalign 

 
� Alignment muss immer 4444 sein! 
� bei 32bitWörtern (die es in Dalvik sind) 

� Aus Eclipse automatisch 

�Warum? 
� Direkter Zugriff mit mmap() 

� Weniger RAM 
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Performance d. Alignment 

$ zipalign [-f ] [-v] [-c] <Alignment> Input.apk Output.apk 



� 
�Mehrere Möglichkeiten 
� Tracing 

� TimingLogger 

�MethodTracing 
� Via Traceview 

� Laufzeit der einzelnen Methoden betrachten 

� TimingLogger 
� Via logcat 

� Erzeugt Meldungen im „base“ log 
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Performance 



� 
�MethodTracing 
� Start des Tracings (z.B. Programmstart) 

 

� Explizites Beenden des Tracings 
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Performance 

Debug.startMethodTracing(“<Name>”); 

Debug.stopMethodTracing(); 



� 
� TimingLogger 
� Erzeugt Meldungen unter Topic "TopicLogTag“ 

 

 

 

� Bessere Unterteilung mit 

� Logcat: 
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Performance 

TimingLogger timings = new TimingLogger("TopicLogTag","preparePicturesFromList"); 
<zu_loggender_Code> 
timings.dumpToLog(); 

adsplits(„<Label>“) 

$ adb logcat -v time TopicLogTag:V  *:E 



� 
� Testen der Geräteleistung 
� Langsame Hardware / Langsamer Emulator 

� Linpack für Android 
� Im Android Market oder im Netz 

� Android 2.1 auf Core2Duo @ 2,4GHz = 1,131 Mflops 
� Übertaktetes Droid bis zu 25Mflops @1,3GHz 

� Nexus One 8-10Mflops 
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Performance 



� 
� Einführung 

� Bestandteile des SDKs 

�Debugging 
� Syslog Anzeigen 

� The Monkey 

� Android Debug Bridge 

� Dalvik Debug Monitor 

� Performance 

�NDKNDKNDKNDK    
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� 
�Native Developement Kit 
� Grundsätzlich eine Toolchain die ARM-Bytecode erzeugt 

� Erlaubt Teile der Anwendung in „native“ Code zu bauen 
� Keine kompletten Anwendungen 

� Unterstützt C / C++ 

� Nicht unbedingt schneller, aber komplexer 

� Wiederbenutzung von bestehendem  

� Enthält OpenGL ES Bibliotheken 
� Und weitere 
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NDK 



� 
� Installation und grundlegende Konfiguration 

�Übersicht über die meisten Tools 
� Emulator 

� Avds erstellen 

�Übersicht über die Debugging Funktionen 
� DDM – Dalvik Debug Monitor 

� ADB – Android Debug Brindge 
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Zusammenfassung 
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